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BarcodeMaker
 Create live EPS barcodes directly in InDesign

Quick Start Guide
If you’re like us, you want to get up and running as fast as possible. Here’s what you do:

1.	 Install BarcodeMaker alongside PatternMaker (see section on Installing Your Teacup Plug-in, below).  Note 

that you need PatternMaker in order to use BarcodeMaker.

2.	 Launch InDesign, open a document, and select any empty frame or path.

3.	 If you don’t see the PatternMaker palette, select Window > PatternMaker.

4.	 Choose a barcode from the palette’s popup menu and click the Apply Pattern button.  Note that all 20 

barcodes now appear in this popup menu.

5.	 Now experiment with the various options in the palette. Each time you make a change, the barcode will update 

on screen.

More Information

Why Do I need PatternMaker?

PatternMaker handles all of the patterns, including barcodes.  On star tup, BarcodeMaker has twenty different barcodes 

that are available in the PatternMaker palette.  These barcodes are being applied by PatternMaker, but supplied by 

BarcodeMaker. 

Using BarcodeMaker

When you load BarcodeMaker and PatternMaker together, the twenty barcodes from BarcodeMaker appear in 

PatternMaker’s dropdown menu.  You use the barcodes in BarcodeMaker just like you would any patterns in PatternMaker.  

See PatternMaker’s documentation for more information.

Thanks for using Teacup Software’s BarcodeMaker!  This 

versatile plug-in can create up to twenty different types 

of barcodes in Adobe InDesign - quickly and easily. 

BarcodeMaker works in conjunction with PatternMaker, 

a free Teacup plug-in, making it simple to tailor fit 

each barcode by using a single user-friendly palette.  

All barcodes come with their own set of options, from 

changing the font to enabling check digits to adjusting 

barcode height. 
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Ink Spread and BarcodeMaker

When bar codes are printed, different combinations of paper and ink may cause the bars in a barcode to become slightly 

wider as the ink spreads out on the paper.  This can be compensated for by using the Ink Spread parameter in any bar code.  

This parameter will simply increase or decrease the width of every bar in the bar code by the given amount.  The default 

amount is - .15 points.

BarcodeMaker and fonts

Barcodes in BarcodeMaker, as with all other PatternMaker patterns, exist as embedded EPS files.  Barcode files may refer to 

fonts within the EPS files, but the font is only referred to by the EPS file, and is not contained within the EPS file.  Therefore, 

features like Package and Preflight need to be aware of the fonts that a barcode refers to.

Unfortunately, InDesign’s Package and Preflight features are not aware of fonts being used in embedded EPS files 

(which is what our barcodes are).  For example, if you create an embedded barcode with a font, and you package it 

without first unembedding it, the font will not be packaged. So, all barcodes should be unembedded before running 

either the Package or Preflight feature. 

Fortunately, PatternMaker makes this process almost automatic for you.  When you try to Package or Preflight when 

PatternMaker is loaded, it will give you a warning with the option to unembed all patterns.  PatternMaker will ask you 

for a location to place the unembeded EPS files.  Once a pattern has been unembeded, it stays unembeded until the 

pattern is modified.  At that point, it becomes embedded again.

Barcode Catalog
 PatternMaker is a free plug-in that comes with three different patterns, each with its own custom set of controls.  

BarcodeMaker works in conjunction with PatternMaker to customize barcodes directly within InDesign. The following 

section explains what the different controls do for BarcodeMaker’s twenty barcodes. 
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Barcode Code 2 of 5

The Industrial Code 2 of 5 barcode is a low density numeric 

barcode that does not require a checksum.  It is a non-

interleaved barcode that is easier to print than the Interleaved 

2 of 5 barcode because check digits are not required.  On the 

other hand, it takes up more space than Interleaved 2 of 5.

n	 Code 2 of 5  –  A variable number of digits.

n	 Include text – Enable human readable text.

n	 Font – Customize and control the font.

n	 Font style – Change the stylistic attributes of the font. 
The font style options vary with each font. 

n	 Font size – Enlarge or reduce the font.

n	 Font position – Adjust the font position in relation to 
the barcode pattern. Widen or reduce the available 
space. 

n	 Barcode height – Control barcode height.  Shorten or 
elongate the barcode.

n	 Ink spread – The amount to add or subtract to the 
width of every bar. Positive numbers will add width, 
negative numbers will subtract width.
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Barcode Code-128

Uses a variable number of ASCII characters and special function 

symbols. There are three sets of character codes it uses. Any 

128 barcode must star t first with a character indicating which 

code set is being used.  The check character is always added 

automatically.  Any non-printable character can be entered via 

its escaped ordinal value, for example ^102 for FNC 1, ^103 

for code set A, ^104 for code set B, and ^105 for code set C.  

For a full list of Code-128 codes, see the chart at the end of this 

document.  BarcodeMaker automatically adds the stop character 

(^106) to the barcode.  Since a caret symbol serves as an 

escape character it must be escaped as ^062 if used in the data.

n	 Code-128 – A variable number of ASCII characters and 
special function symbols..

n	 Include text – Enable human readable text.

n	 Font – Customize and control the font.

n	 Font style – Change the stylistic attributes of the font. 
The font style options vary with each font. 

n	 Font size – Enlarge or reduce the fon.t

n	 Font position – Adjust the font position in relation to 
the barcode pattern. Widen or reduce the available 
space.

.	 Include check digit - Add check digit.

n	 Barcode height – Control barcode height.  Shorten or 
elongate the barcode.

n	 Ink spread – The amount to add or subtract to the 
width of every bar.  Positive numbers will add width, 
negative numbers will subtract width. 
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Barcode Code-39

Code 39 is an easy to use alpha-numeric barcode. It is also 

commonly called LOGMARS, Code 3 of 9 or the 3 of 9 Code..

n	 Code-39 – A variable number of characters, digits and 
any of the symbols - . * $ / + %

n	 Include text – Enable human readable text.

n	 Font – Customize and control the font.

n	 Font style – Change the stylistic attributes of the font. 
The font style options vary with each font. 

n	 Font size – Enlarge or reduce the font.

n	 Font position – Adjust the font position in relation to 
the barcode pattern. Widen or reduce the available 
space. 

n	 Include check digit – Add check digit.

n	 Enable check digit –  Allow check digit to be added.

n	 Barcode height – Control barcode height.  Shorten or 
elongate the barcode.

n	 Ink spread – The amount to add or subtract to the 
width of every bar.  Positive numbers will add width, 
negative numbers will subtract width. 
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Barcode Code-93

A higher density and data security enhancement to Code 39. It 

is an alphanumeric, variable length symbology..

n	 Code-93 – Alphanumeric text of variable length

n	 Include text – Enable human readable text.

n	 Font – Customize and control the font.

n	 Font style – Change the stylistic attributes of the font. 
The font style options vary with each font. 

n	 Font size – Enlarge or reduce the font.

n	 Font position – Adjust the font position in relation to 
the barcode pattern. Widen or reduce the available 
space. 

n	 Barcode height – Control barcode height.  Shorten or 
elongate the barcode.

n	 Ink spread – The amount to add or subtract to the 
width of every bar.  Positive numbers will add width, 
negative numbers will subtract width. 
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Barcode EAN-13

EAN-13, based upon the UPC-A standard, was implemented 

by the International Article Numbering Association (EAN) in 

Europe.  EAN-13 is a superset of UPC-A. This means that any 

software or hardware capable of reading an EAN-13 symbol will 

automatically be able to read an UPC-A symbol.

n	 Code EAN-13 – 12 or 13 digits. If just 12 digits 
are entered then the check digit is calculated 
automatically. 

n	 Include text – Enable human readable text.

n	 Font – Customize and control the font.

n	 Font style – Change the stylistic attributes of the font. 
The font style options vary with each font. 

n	 Font size – Enlarge or reduce the font.

n	 Font position – Adjust the font position in relation to 
the barcode pattern. Widen or reduce the available 
space. 

n	 Barcode height – Control barcode height.  Shorten or 
elongate the barcode.

n	 Ink spread – The amount to add or subtract to the 
width of every bar.  Positive numbers will add width, 
negative numbers will subtract width. 
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Barcode EAN-2 

EAN 2 is an add-on code  only used in addition to EAN 13, 

EAN 8 and UPC.  It has no check digit.

n	 Code EAN-2  – 2 digits.

n	 Include text – Enable human readable text.

n	 Font – Customize and control the font.

n	 Font style – Change the stylistic attributes of the font. 
The font style options vary with each font. 

n	 Font size – Enlarge or reduce the font.

n	 Font position – Adjust the font position in relation to 
the barcode pattern. Widen or reduce the available 
space. 

n	 Barcode height – Control barcode height.  Shorten or 
elongate the barcode.

n	 Ink spread – The amount to add or subtract to the 
width of every bar.  Positive numbers will add width, 
negative numbers will subtract width. 
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Barcode EAN-5 

EAN 5 is an add-on code  only used in addition to ISBN, EAN 

13, EAN 8 and UPC.  It has no check digit. It is often used to 

encode the price of a book.

n	 Code EAN-5  – 5 digits.

n	 Include text – Enable human readable text.

n	 Font – Customize and control the font.

n	 Font style – Change the stylistic attributes of the font. 
The font style options vary with each font. 

n	 Font size – Enlarge or reduce the font.

n	 Font position – Adjust the font position in relation to 
the barcode pattern. Widen or reduce the available 
space. 

n	 Barcode height – Control barcode height.  Shorten or 
elongate the barcode.

n	 Ink spread – The amount to add or subtract to the 
width of every bar.  Positive numbers will add width, 
negative numbers will subtract width. 
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Barcode EAN-8 

EAN 8 is the short form of EAN-13. This code is usually only 

used if the package is too small for an EAN-13 code.

n	 Code EAN-8 – 8 digits.

n	 Include text – Enable human readable text.

n	 Font – Customize and control the font.

n	 Font style – Change the stylistic attributes of the font. 
The font style options vary with each font. 

n	 Font size – Enlarge or reduce the font.

n	 Font position – Adjust the font position in relation to 
the barcode pattern. Widen or reduce the available 
space. 

n	 Barcode height – Control barcode height.  Shorten or 
elongate the barcode.

n	 Ink spread – The amount to add or subtract to the 
width of every bar.  Positive numbers will add width, 
negative numbers will subtract width. 
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Barcode FIM 

Facing Identification Mark (FIM) barcodes are used by the US 

post office for facing and presorting business and courtesy reply 

mail..

n	 FIM – Which of the four currently available FIM codes 
to use.

n	 Ink spread – The amount to add or subtract to the 
width of every bar.  Positive numbers will add width, 
negative numbers will subtract width. 
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Barcode ISBN 
n	 ISBN – The ISBN bar code can handle either 10 or 13 

digit numbers.  The user can input 9 or 12 digits and 
BarcodeMaker will calculate the last check-digit, or the 
user can enter all 10 or 13 digits themselves.  If the user 
enters the last digit themselves, it will be displayed in the 
text above the barcode, but the barcode itself will always 
use the calculated check digit and ignore the final digit 
entered by the user.

n	 Dual Numbering – For ISBN 13 only.  Whether to put 
both the ISBN 10 and 13 numbers above each barcode.  
BarcodeMaker will automatically calculate the correct 
ISBN 10 number to appear.

Note: You can choose whether the 13 or the 10 digit number 
shows above or below, and whether a colon appears before the 
number.  Choose “Pattern Options” from the flyout menu and you will 
see these options appear.  To apply the change to existing barcodes, 
you must select the barcode and click “Reset Pattern.”

n	 Suffix – An optional two or five digit suffix that will be 
printed to the right of the ISBN.  This is also sometimes 
referred to as the “ISBN addon”.  The suffix is encoded 
as EAN-2 or EAN-5.

n	 Include text – Enable human readable text.

n	 Whitespace – Whether to include a symbol to the end 
of the barcode to indicate a quiet zone

n	 Lead EAN – Whether to include the text “EAN” to the 
left of the barcode.

n	 Top font – Customize and control font on top of ISBN 
barcode.

n	 Top font style –Change stylistic attributes of the top font. 
The font style options vary with each font. 

n	 Top font size – Enlarge or reduce the top font.

n	 Top font position – Adjust the top font position in  
relation to the barcode. Widen or reduce the available 
space.

n	 Font – Customize and control the font.

n	 Font style – Change the stylistic attributes of the font. 
The font style options vary with each font. 

n	 Font size – Enlarge or reduce the font.

n	 Font position – Adjust the font position in relation to the 
barcode pattern. Widen or reduce the available space. 

n	 Barcode height – Control barcode height.  Shorten or 
elongate the barcode.

n	 Ink spread – The amount to add or subtract to the width 
of every bar.  Positive numbers will add width, negative 
numbers will subtract width. 

n	 Strippable – This feature is used by the trade 
paperback industry to indicate if books can be 
returned by simply returning the stripped off 
covers.  A set of symbols is added to the right 
of the barcode to indicate this.
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Barcode ISSN 
n	 ISSN – The ISSN bar code consists of nine or ten digits 

and at least one dash.  The normal sequence is as follows:

Element Digits

ISSN Number 7 digits (usually with a dash 
after the first 4 digits)

Sequence Variant / 
price code)

2 digits

Check digit 
(optional)

1 digit (or the letter X)

The human readable text at the top of the code only 
shows the ISSN number and ISSN check digit, and does 
not show the sequence number.  Note that the ISSN 
check digit displayed at the top is different from the EAN 
check digit displayed underneath and encoded in the 
barcode.  BarcodeMaker will automatically calculate and 
display the ISSN check digit if you only enter nine digits 
and don’t enter the check digit yourself.

	 The sequence number is encoded in the barcode and 
shows in the human readable text at the bottom of the 
barcode.  Also at the bottom of the barcode, the EAN13 
prefix specific for serial publications, 977, is displayed at 
the beginning of the barcode, and the EAN check digit is 
calculated and displayed at the end of the barcode.

n	 Suffix – An optional two digit suffix that will be 
printed to the right of the ISSN.  This is also sometimes 
referred to as the issue number.  The suffix is encoded 
as EAN-2.

n	 Include text – Enable human readable text.

n	 Top font – Customize and control font on top of ISBN 
barcode.

n	 Top font style –Change stylistic attributes of the top 
font. The font style options vary with each font. 

n	 Top font size – Enlarge or reduce the top font.

n	 Top font position – Adjust the top font position in  
relation to the barcode. Widen or reduce the available 
space.

n	 Font – Customize and control the font.

n	 Font style – Change the stylistic attributes of the font. 
The font style options vary with each font. 

n	 Font size – Enlarge or reduce the font.

n	 Font position – Adjust the font position in relation to the 
barcode pattern. Widen or reduce the available space. 

n	 Barcode height – Control barcode height.  
Shorten or elongate the barcode.

n	 Ink spread – The amount to add or 
subtract to the width of every bar.  
Positive numbers will add width, 
negative numbers will subtract width. 
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Barcode Interleaved 2 of 5 and ITF-14 

Code 2 of 5 Interleaved is a numeric code consisting of the 

digits from 0 to 9. It has no built in check digit. The advantage of 

Code 2 of 5 Interleaved is over the Code 2 of 5 is that it takes 

up less physical space. Code 2 of 5 Interleaved is only valid if 

there is a even number of digits. To display an odd number of 

digits you have to add a zero to the beginning (123 becomes 

0123) or you may use your own check digit.

n	 Code Interleaved 2 of 5 and ITF-14  – Variable number 
of digits. An ITF-14 is 14 characters and does not have 
a check digit. The data may be automatically prefixed 
with  0 to make the data, including the optional check 
digit, of even length. 

n	 Include text – Enable human readable text.

n	 Font – Customize and control the font.

n	 Font style – Change the stylistic attributes of the font. 
The font style options vary with each font. 

n	 Font size – Enlarge or reduce the font.

n	 Font position – Adjust the font position in relation to 
the barcode pattern. Widen or reduce the available 
space.

n	 Include check digit – Add check digit.

n	 Enable check digit – Allow check digit to be added. 

n	 Barcode height – Control barcode height.  Shorten or 
elongate the barcode.

n	 Ink spread – The amount to add or subtract to the 
width of every bar.  Positive numbers will add width, 
negative numbers will subtract width. 
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Barcode KIX 

Used by the Dutch PTT for bulk mail addressing..

n	 KIX – The number to use.

n	 Include text – Enable human readable text.

n	 Font – Customize and control the font.

n	 Font style – Change the stylistic attributes of the font. 
The font style options vary with each font. 

n	 Font size – Enlarge or reduce the font.

n	 Font position – Adjust the font position in relation to 
the barcode pattern. Widen or reduce the available 
space.

n	 Barcode height – Control barcode height.  Shorten or 
elongate the barcode.

n	 Ink spread – The amount to add or subtract to the 
width of every bar.  Positive numbers will add width, 
negative numbers will subtract width. 



Simple, elegant solutions for Adobe InDesign

Page 16

Barcode MSI

MSI is also known as Modified Plessey. MSI is a continuous, non-

self-checking symbology. While the length of an MSI barcode can 

be of any length, a given application usually implements a fixed-

length code.

n	 Code MSI  – A variable number digits.

n	 Include text – Enable human readable text.

n	 Font – Customize and control the font.

n	 Font style – Change the stylistic attributes of the font. 
The font style options vary with each font. 

n	 Font size – Enlarge or reduce the font.

n	 Font position – Adjust the font position in relation to 
the barcode pattern. Widen or reduce the available 
space.

n	 Include check digit – Add check digit.

n	 Enable check digit – Allow check digit to be added. 

n	 Barcode height – Control barcode height.  Shorten or 
elongate the barcode.

n	 Ink spread – The amount to add or subtract to the 
width of every bar.  Positive numbers will add width, 
negative numbers will subtract width. 
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Barcode Plessey

The MSI Plessey barcode has been designed by the Plessey 

Company, England in 1971.  MSI is a variant of Plessey.  Encodes 

a variable number of hexadecimal characters.

n	 Code Plessey  – A variable number of hexadecimal 
characters (0 - 9 and A - F). Check digits are always 
added automatically.

n	 Include text – Enable human readable text.

n	 Font – Customize and control the font.

n	 Font style – Change the stylistic attributes of the font. 
The font style options vary with each font. 

n	 Font size – Enlarge or reduce the font.

n	 Font position – Adjust the font position in relation to 
the barcode pattern. Widen or reduce the available 
space.

n	 Include check digit – Add check digit.

n	 Barcode height – Control barcode height.  Shorten or 
elongate the barcode.

n	 Ink spread – The amount to add or subtract to the 
width of every bar.  Positive numbers will add width, 
negative numbers will subtract width. 
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Barcode Postnet

Developed by the US Postal Service, Postnet barcodes encode 

zip code information on letter mail for rapid and reliable sorting 

by barcode sorters. The POSTNET barcode can represent a 

five-digit ZIP Code (32 bars), a nine-digit ZIP+4 code (52 bars), 

or an eleven-digit delivery point code (62 bars).

n	 Code Postnet  – A variable number digits . A check 
digit is always added automatically.

n	 Include text – Enable human readable text.

n	 Font – Customize and control the font.

n	 Font style – Change the stylistic attributes of the font. 
The font style options vary with each font. 

n	 Font size – Enlarge or reduce the font.

n	 Font position – Adjust the font position in relation to 
the barcode pattern. Widen or reduce the available 
space.

n	 Include check digit – Add check digit.

n	 Barcode height – Control barcode height.  Shorten or 
elongate the barcode.

n	 Ink spread – The amount to add or subtract to the 
width of every bar.  Positive numbers will add width, 
negative numbers will subtract width. 
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Barcode Rationalized Codabar

Codabar was designed for character self-checking eliminating 

the requirement for checksum characters.  Checksums can 

be included, however.  The difference between Rationalized 

Codabar and Traditional Codabar is that Rational assigns only 2 

element widths for wide and narrow.

n	 Code Rationalized Codabar  – Variable number of 
digits and any of the symbols - $ / . + ABCD

n	 Include text – Enable human readable text.

n	 Font – Customize and control the font.

n	 Font style – Change the stylistic attributes of the font. 
The font style options vary with each font. 

n	 Font size – Enlarge or reduce the font.

n	 Font position – Adjust the font position in relation to 
the barcode pattern. Widen or reduce the available 
space.

n	 Include check digit – Add check digit.

n	 Enable check digit – Allow check digit to be added. 

n	 Barcode height – Control barcode height.  Shorten or 
elongate the barcode.

n	 Ink spread – The amount to add or subtract to the 
width of every bar.  Positive numbers will add width, 
negative numbers will subtract width. 
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Barcode RoyalMail

The Royal Mail 4-state Customer Code(RM4SCC) is a height-

modulated barcode symbology for use in automated mail sort 

process.

n	 Code RoyalMail  – A variable number of digits 
and capital letters.  Check digits are always added 
automatically.

n	 Include text – Enable human readable text.

n	 Font – Customize and control the font.

n	 Font style – Change the stylistic attributes of the font. 
The font style options vary with each font. 

n	 Font size – Enlarge or reduce the font.

n	 Font position – Adjust the font position in relation to 
the barcode pattern. Widen or reduce the available 
space.

n	 Include check digit – Add check digit.

n	 Barcode height – Control barcode height.  Shorten or 
elongate the barcode.

n	 Ink spread – The amount to add or subtract to the 
width of every bar.  Positive numbers will add width, 
negative numbers will subtract width. 
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Barcode UPC-A

UPC-A encodes 11 digits of numeric (0 through 9) message 

data along with a trailing check digit, for a total of 12 digits 

of barcode data.  UPC-A is a very common barcode and is 

sometimes referred to as UPC.

n	 Code UPC-A  – 11 or 12 digits. If only 11 digits are 
entered then the check digit is calculated automatically.

S	 Suffix – An optional two or five digit suffix that will be 
printed to the right of the UPC.  This is also sometimes 
referred to as the “UPC addon”.  The suffix is encoded as 
EAN-2 or EAN-5. 

n	 Include text – Enable human readable text.

n	 Whitespace – Whether to include a symbol to the end 
of the barcode to indicate a quiet zone

n	 Lead UPC – Whether to include the text “UPC” to the 
left of the barcode.

n	 Font – Customize and control the font.

n	 Font style – Change the stylistic attributes of the font. 
The font style options vary with each font. 

n	 Font size – Enlarge or reduce the font.

n	 Font position – Adjust the font position in relation to the 
barcode pattern. Widen or reduce the available space.

n	 Barcode height – Control barcode height.  Shorten or 
elongate the barcode.

n	 Ink spread – The amount to add or subtract to the width 
of every bar.  Positive numbers will add width, negative 
numbers will subtract width. 

n	 Strippable – This feature is used by the trade paperback 
industry to indicate if books can be returned by simply 
returning the stripped off covers.  A set of symbols is 
added to the right of the barcode to indicate this.
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Barcode UPC-E

UPC-E is a variation of UPC-A that allows for a more compact 

barcode by eliminating “extra” zeros. The resulting barcode 

is physically smaller than UPC-A, and so it is often used on 

products that have small packaging and require a physically 

smaller barcode.

n	 Code UPC-E  – 7 or 8 digits. If just 7 digits are entered 
then the check digit is calculated automatically.

n	 Include text – Enable human readable text.

n	 Font – Customize and control the font.

n	 Font style – Change the stylistic attributes of the font. 
The font style options vary with each font. 

n	 Font size – Enlarge or reduce the font.

n	 Font position – Adjust the font position in relation to 
the barcode pattern. Widen or reduce the available 
space.

n	 Barcode height – Control barcode height.  Shorten or 
elongate the barcode.

n	 Ink spread – The amount to add or subtract to the 
width of every bar.  Positive numbers will add width, 
negative numbers will subtract width. 
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Installing Your Teacup Plug-in
Plug-ins for InDesign are  files that end with a suffix of “.pln” (on Macintosh for CS-2, the suffix will be “.pln.framework”).  

In order for InDesign to load a plug-in, it has to be in the “Plug-Ins” directory wherever you have InDesign installed.  

You can put a plug-in anywhere underneath that directory, and InDesign will load it.

To install your Teacup plug-in, simply take the .pln file (or .pln.framework file for CS-2 Macintosh), and drop it 

anywhere in your “Plug-Ins” folder.  You might want to create a subdirectory called “Teacup” to hold any Teacup plug-

ins you use.

When you are installing on the Macintosh platform, be careful to make sure that everybody has read access to the 

plug-in files.  You can do this by selecting “File > Get Info” from the finder and making sure that everyone has read 

access.  This will assure that the plug-in will load for all users.

Purchasing and Activating Your Teacup Plug-In
When you purchase a Teacup plug-in, the 20-day demo version is unlocked into the full working version.  The demo is fully 

functioning for 20 days.  After 20 days, it ceases to function entirely, until a purchase is made and it is unlcoked.  After a 

purchase is made, the plug-in will be fully working without any time limit.

There are a number of ways you can make a purchase.  You can make your purchase through a sales channel such as a 

reseller or through our online store.  Or you can now purchase Teacup plug-ins without ever leaving InDesign!

When you purchase through a traditional sales channel, you are sent a serial number that you then use to activate 

the demo version to be the full working version.  When you purchase directly within InDesign, activation is done 

automatically as part of the purchase process. Once the plug-in is purchased, it’s activated and ready to go!

Please note that you must be logged in as an administrator to activate or purchase the plug-in.

To purchase within InDesign

1. There are two ways to star t the purchase process
●	 From the plug-in’s splash screen, you can press the “Purchase” button

●	 From the Help > About Plug-Ins menu (Win) or InDesign > About Plug-Ins menu (Mac), select Teacup > 
[plug-in name] > Purchase

2.	 From that point onward, a wizard will appear that will take you through the purchase process, collect your 

payment information, and open a secure, encrypted connection to make the purchase and activate the plug-in.
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To activate a plug-in purchased from another sales channel

1. 	There are two ways to star t the activation process
●	 From the plug-in’s splash 

screen, you can press the 
“Activate” button

●	 From the Help > About 
Plug-Ins menu (Win) or 
InDesign > About Plug-Ins 
menu (Mac), select Teacup > 
[plug-in name] > Activate

2. 	A dialog will appear that has 

two sections to it.  In the first 

section, you enter your activation 

key.  In the second step, you click 

“Activate Automatically.”  This will 

connect with Teacup’s servers, 

check if the serial number is valid, and if it is, will unlock the plug-in.

3.	 When you’re finished activating, click the “Done” button to dismiss the dialog.
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Scripting Guide
PatternMaker adds a single property and a single method to the PageItem object.  See the sample script that comes 

with BarcodeMaker to see how to script the plug-in.  The following table gives more information.

PatternMaker methods

Name Paramaters Description

JavaScript:

setpatternparam

AppleScript and 
VBScript:

SetPatternParam

Name Type Description

paramName String, 
required

The name of the 
parameter to set

paramValue String, 
required

The value of the 
parameter.  “true” 
or “false” for 
boolean values, 
an integer for any 
measurements 
(always in points)

Sets the paramater 
of a pattern.  For 
example, for an 
ISBN barcode, 
parameters 
include “ISBN”, 
“Top font”, “Include 
text”, etc.  Type 
the name of the 
parameter exactly 
as it appears in 
the PatternMaker 
palette.

JavaScript and 
AppleScript:

pattern

VBScript:

Pattern

This is a String property.. Set this property 
equal to the 
pattern name to 
apply a pattern.  
The pattern name 
should be exactly 
as it appears in 
the PatternMaker 
dropdown list of 
patterns.

JavaScript:

patternParameters

VBScript:

PatternParameters

AppleScript:

pattern parameters

This is a string property describing all parameters in 
a given parameter in a single string of name value 
pairs.  Each pair is separated by a tilde (~) and names 
and values are separated by a colon (:).  So a typical 
pattern’s parameters might look like this:

EAN-2:10~Include text:true~Font:Verdana~Font 
style:Regular~Font size:10~Font position:0~Barcode 
Height:1~Ink Spread:0.15

Setting this 
property will set 
all parameters at 
once.  it is much 
faster to use this 
property than to 
set parameters 
one at a time with 
SetPatternParam.
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Value Code Set A Code Set B Code Set C

0 SP SP 00 

1 ! ! 01 

2 “ “ 02 

3 # # 03 

4 $ $ 04 

5 % % 05 

6 & & 06 

7 ‘ ‘ 07 

8 ( ( 08 

9 ) ) 09 

10 * * 10 

11 + + 11 

12 , , 12 

13 - - 13 

14 . . 14 

15 / / 15 

16 0 0 16 

17 1 1 17 

18 2 2 18 

19 3 3 19 

20 4 4 20 

21 5 5 21 

22 6 6 22 

23 7 7 23 

24 8 8 24 

25 9 9 25 

26 : : 26 

27 ; ; 27 

28 < < 28 

29 = = 29 

30 > > 30 

31 ? ? 31 

32 @ @ 32 

33 A A 33 

34 B B 34 

Value Code Set A Code Set B Code Set C

35 C C 35 

36 D D 36 

37 E E 37 

38 F F 38 

39 G G 39 

40 H H 40 

41 I I 41 

42 J J 42 

43 K K 43 

44 L L 44 

45 M M 45 

46 N N 46 

47 O O 47 

48 P P 48 

49 Q Q 49 

50 R R 50 

51 S S 51 

52 T T 52 

53 U U 53 

54 V V 54 

55 W W 55 

56 X X 56 

57 Y Y 57 

58 Z Z 58 

59 [ [ 59 

60 \ \ 60 

61 ] ] 61 

62 ^ ^ 62 

63 _ _ 63 

64 NUL ` 64 

65 SOH a 65 

66 STX b 66 

67 ETX c 67 

68 EOT d 68 

69 ENQ e 69 

Code 128 Codes
This table shows the codes and values for the different character sets in Code 128.

Code 128 Barcode Table
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Value Code Set A Code Set B Code Set C

70 ACK f 70 

71 BEL g 71 

72 BS h 72 

73 HT i 73 

74 LF j 74 

75 VT k 75 

76 FF I 76 

77 CR m 77 

78 SO n 78 

79 SI o 79 

80 DLE p 80 

81 DC1 q 81 

82 DC2 r 82 

83 DC3 s 83 

84 DC4 t 84 

85 NAK u 85 

86 SYN v 86 

87 ETB w 87 

88 CAN x 88 

89 EM y 89 

90 SUB z 90 

91 ESC { 91 

92 FS | 92 

93 GS } 93 

94 RS ~ 94 

95 US DEL 95 

96 FNC 3 FNC 3 96 

97 FNC 2 FNC 2 97 

98 SHIFT SHIFT 98 

99 CODE C CODE C 99 

100 CODE B FNC 4 CODE B 

101 FNC 4 CODE A CODE A 

102 FNC 1 FNC 1 FNC 1 

103 Star t A Star t A Star t A 

104 Star t B Star t B Star t B 

105 Star t C Star t C Star t C 

106 Stop Stop Stop 
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